Copyright 2013 Jupiter Avionics Corp.
All rights reserved

Jupiter Avionics Corporation (JAC) permits a single copy of this manual to be printed or downloaded for the express use of an installing agency. Any such electronic or printed copy of this manual must contain the complete text of this copyright notice. Any unauthorized commercial distribution of this manual is strictly prohibited. Except as described above, no part of this manual may be reproduced, copied, transmitted, disseminated, downloaded, or stored in any storage medium for any purpose without the express prior written consent of JAC.

IMPORTANT:
Information in this document is subject to change without notice.
To confirm the current revision status of this manual, visit the JAC website:

www.jupiteravionics.com

<table>
<thead>
<tr>
<th>Revision</th>
<th>Rev Date</th>
<th>Description</th>
<th>ECR</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Jan 2013</td>
<td>Initial Release</td>
<td>1778</td>
</tr>
<tr>
<td>B</td>
<td>Sep 2014</td>
<td>Updated at Version v0.13.1</td>
<td>2814</td>
</tr>
<tr>
<td>C</td>
<td>Oct 2015</td>
<td>Updated at version v0.30.0</td>
<td>3810</td>
</tr>
<tr>
<td>D</td>
<td>Jun 2017</td>
<td>Updated at version v0.42.0</td>
<td>4902</td>
</tr>
</tbody>
</table>

Prepared: MPB  
Checked: JAC 06-19-17 MWH  
Approved: JAC 06-20-17 KDV
Table of Contents

SECTION 1 - DESCRIPTION
  1.1 System Overview ................................................................................................................................. 1
  1.2 Features Overview ................................................................................................................................. 1
    1.2.1 Configuration Cabling Requirements ......................................................................................... 1
  1.3 Using ProCS™ To Create Custom Avionics Equipment ........................................................................ 1

SECTION 2 – INSTALLATION
  2.1 Introduction ........................................................................................................................................... 2
  2.2 System Requirements ............................................................................................................................. 2
  2.3 Software Installation Procedures ........................................................................................................ 2
    2.3.1 Download .exe File ....................................................................................................................... 2
    2.3.2 Download .exe file ...................................................................................................................... 3
  2.3.3 ProCS™ Installation ....................................................................................................................... 3
  2.3.4 ProCS™ Familiarization ................................................................................................................... 5
  2.4 Cable Connections ................................................................................................................................. 6
    2.4.1 Driver for Cable CAB-USB-0002 and CAB-USB-0006 ............................................................... 7
    2.4.2 Selecting the ProCS™ COM Port ............................................................................................... 7
    2.4.3 COM Port Setting via Device Manager ....................................................................................... 8
    2.4.4 Establishing Communication ..................................................................................................... 8

SECTION 3 – OPERATION
  3.1 Introduction ........................................................................................................................................... 9
  3.2 Launching the Software .......................................................................................................................... 9
  3.3 Initial ProCS™ Screen ............................................................................................................................ 9
    3.3.1 Toolbar .......................................................................................................................................... 9
    3.3.2 Messages Window ....................................................................................................................... 10
    3.3.3 Status bar ..................................................................................................................................... 10
    3.3.4 Products Window ....................................................................................................................... 11
    3.3.5 Editing Windows .......................................................................................................................... 12
    3.3.6 Saving Changes ............................................................................................................................ 17
    3.3.7 Compare or Display/Print Configuration Data ........................................................................... 18

SECTION 4 – ORDERING A CUSTOM UNIT
  4.1 Ordering a Custom Unit ....................................................................................................................... 19
    4.1.1 Launching the Software .............................................................................................................. 19
    4.1.2 Specifying the Product Configuration ....................................................................................... 19
SECTION 1 - DESCRIPTION

1.1 System Overview

Product Configuration Software (ProCS™) is available to enable the installer to configure all the necessary level settings and options into Jupiter Avionics Corporation (JAC) avionics equipment.

The software guides the installer through a logical series of steps so that every aspect of the configuration parameters is covered.

1.2 Features Overview

Connection from the computer to the JAC device is made using adapter cables. Refer to section 1.2.1.

Access to the JAC device is via a 3.5mm jack socket. This may be labelled i/o or ♫/io on products with a faceplate or user controls. Refer to the product manual to confirm the location on other JAC products. The socket may be located on the main panel (for panel mount devices), beside the main connector (remote mount) or on one side of the wireless JAC device. This means that modification of any operating parameters can be achieved without disconnecting or removing the device from the aircraft.

The software also makes it simple to keep records of configuration specifics for different customers or missions.

1.2.1 Configuration Cabling Requirements

To configure a JAC product, it is necessary to load the Product Configuration Software (ProCS™) onto a Windows-based computer as described in section 2.3 of this manual.

The cables in Cabling Option 1 below are provided as part of the Dealer Kit (JAC Part No. DLR-KIT) that is available to approved installers. The cable in Cabling option 2 may be purchased from JAC. For full connection information, refer to section 2.4. To determine if one or both of these options may be used, refer to the ProCS Setup line(s) for the specific device under consideration. (Normally, option 1 must be used for programming a JA95 or JRAC series Audio controller.)

The cables required to configure the products are not usually included with the avionics equipment. Refer to the JAC website – jupiteravionics.com/producttestequipment for details of the available cables.

Cabling option 1:

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>JAC Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB A to RS232 9-Pin Cable</td>
<td>CAB-USB-0002</td>
</tr>
<tr>
<td>1</td>
<td>Configuration Cable</td>
<td>JA99-001</td>
</tr>
</tbody>
</table>

Cabling option 2:

<table>
<thead>
<tr>
<th>Quantity</th>
<th>Description</th>
<th>JAC Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USB A Male to RS232 3.5mm Plug</td>
<td>CAB-USB-0006</td>
</tr>
</tbody>
</table>

1.3 Using ProCS™ To Create Custom Avionics Equipment

The ProCS™ software can be used to specify all the desired features when ordering new avionics equipment from JAC (see section 4), or to change the operating parameters of an existing unit. This, together with JAC’s field-changeable illuminated legends, means that dealer inventory can be considerably reduced, as each unit can be modified to suit multiple customers and many different mission configurations.
SECTION 2 – INSTALLATION

2.1 Introduction

This section contains installation information for the ProCS™ (Product Configuration Software) from Jupiter Avionics Corporation (JAC).

2.2 System Requirements

The ProCS™ software requires a PC or laptop running Windows 7® or higher. The appearance of the screens may vary depending on the Windows version and personalization.

Note: The description below is based upon Windows 7. Any known differences for use with Windows 8 or 10 will be described as an additional note with the Windows logos.

2.3 Software Installation Procedures

The ProCS™ application can be found on the Jupiter Avionics website – www.jupiteravionics.com/productsoftware.

2.3.1 Download .exe File

To download the ProCS™.exe file, click on the relevant line (for example ‘Download ProCS™ Version v0.38.1 (exe)’) and select 'Run' to initiate the ProCS™ Setup Wizard, or 'Save' to save the file to your computer.

If your firewall will not allow downloads of .exe files, see section 2.3.2 below.

A window may open with a message similar to that shown below; select 'View Downloads' and then click on the file.
If a message similar to this appears, select ‘Run anyway’.

2.3.2 Download .ex_ File

As some systems will not allow download of .exe files, an alternative method is provided. Click on the relevant line - for example ‘Download ProCS™ Version v0.41.1 (ex_)’ and download and save the file. Then locate the file and rename to change the file extension to .exe - for example ‘Download ProCS™ Version v0.41.1 (exe)’. Then double click on the renamed file to initiate installation of the ProCS™ software on your laptop or PC.

Any cautions should be treated as shown in section 2.3.1.

2.3.3 ProCS™ Installation

Running the file launches the ProCS™ Setup Wizard.

The ‘Welcome to the ProCS Setup Wizard’ screen will appear. Click ‘Next >’ to proceed with the installation, or ‘Cancel’ to stop.

The default (recommended) location for the files is shown on this screen, but you may browse your computer to select an alternative location.
The selected locations for the files are displayed, but you may go back and browse your computer to make changes.

Check this box to create a desktop icon (recommended).

The shortcut location is selected from this screen.
2.3.4 ProCS™ Familiarization

As soon as ProCS™ is installed on the computer, it can be accessed to allow a new user to become familiar with the program features. To review 'Demo Mode' it is not necessary to connect a product.
2.4 Cable Connections

Using Dealer Kit cables JA99-001 and CAB-USB-0002, or CAB-USB-0006, (see section 1.2.1) connect the PC or laptop to the avionics equipment. The diagram below is shown as an example – the specific cabling requirements for each product are provided within ProCS™ by accessing the menu tree ProCS Setup line(s). (See section 3.3.4.)

There are references in ProCS™ Setup drawings to CAB-USB-0008 and CAB-USB-0010. These are Maintenance-specific cables that will be described in the relevant Maintenance Manuals.
2.4.1 Driver for Cable CAB-USB-0002 and CAB-USB-0006

When cable CAB-USB-0002 or CAB-USB-0006 is plugged into the computer for the first time, Windows will search for a driver. A series of screens may appear sequentially to advise the progress of the software installation.

The device identification number for the cable is shown here.

This screen shows the USB serial port to which the cable is connected (COM3 in this example).

**Note**: If Windows does not automatically install the driver, a driver installer and driver installation guides can be found on the JAC website - www.jupiteravionics.com/producttestequipment.

2.4.2 Selecting the ProCS™ COM Port

The ProCS™ must have the correct COM port set to communicate with the avionics equipment. This can be determined through the **Applications Options** window, or by opening the Windows Device Manager and locating the COM-USB-0002 or COM-USB-0006 cable as shown in section 3. The cable and ProCS™ COM port numbers must match.

From the **ProCS™ toolbar main menu** (see section 3.3.1), click to open the **Edit** menu and select **Options**.

The ‘**Application Options**’ window will open. Match the ProCS™ COM port number to the CAB-USB-0002 or CAB-USB-0006 port.

The port number can be changed using the up/down arrows. When the correct port has been selected, click **OK**.
2.4.3  COM Port Setting via Device Manager

2.4.3.1  Finding the Device Manager

In Windows 7, the Device Manager is found by selecting 'Devices and Printers' from the start-up menu.

The Devices and Printers icons window will open.

Under 'Unspecified', locate the US232R icon (the FDTI CAB-USB-0002 or CAB-USB-0006 driver). Double-click on the icon to open the US232R Properties window, and then select the Hardware tab to find the COM port.

Alternatively, select 'Control Panel' from the start-up menu, and then > Hardware and Sound > Device Manager to reach the window shown.

The COM port number will be shown beside the USB Serial Port.

In Windows 8 or Windows 10, select the US232R via the Device Manager (Settings > PC Info > Device Manager > Ports (COM & LPT) > USB Serial Port.

Double click on 'USB Serial Port' to open the required properties windows.

2.4.4  Establishing Communication

Once the COM port is selected, the ProCS™ will send a hardware signal to the avionics equipment Config port to enable communication from the equipment. Refer to the avionics equipment's interconnect drawing for the MODE SELECT signal on the configuration connector.

After power is applied, the avionics equipment will send a data signal to the ProCS™.

When using the CAB-USB-0002 cable the right LED will illuminate briefly when the data signal is sent to the ProCS™ and the left LED will illuminate when the ProCS™ is sending data to the avionics equipment.
SECTION 3 – OPERATION

3.1 Introduction

This section describes how the ProCS™ is used to configure equipment manufactured by Jupiter Avionics Corporation (JAC).

Note: The JA95-001 will be used as an example – other products will have different configurable functions, but the procedure will be similar. Refer to the specific product manual for more information.

3.2 Launching the Software

After installing the ProCS™ software on a PC or laptop, launch the software by either checking the ‘Launch ProCS’ checkbox on the ‘Completing the ProCS setup Wizard’ window, by double clicking the ProCS™ icon on the desktop if that option was selected, or by opening it from the folder where it was saved during installation.

3.3 Initial ProCS™ Screen

The main components of the initial ProCS™ screen are a toolbar, a products window, an editing window, a selectable Messages window and a status bar. As different parts of ProCS™ are accessed, the information in these areas will change.

3.3.1 Toolbar

The toolbar is used for file management. Clicking on the headings in the main menu will open drop-down menus that list the available options for each category.

The ‘New’, ‘Open’ and ‘Save’ toolbar icons operate as described in the Main File menu below. ‘Back’ and ‘Forward’ return you to the previous or last screen, and the ‘Goto’ box is a shortcut to the complete list of configurable products.
The Main ‘File’ Menu

‘New’ opens a standard version of the product configuration data file directly from ProCS™. ‘Open’ will open the data folder where previous saved versions of the data have been stored on this computer. If this is the first time that the software has been used, there will be no saved data. ‘Save’, ‘Save As …’ and ‘Save All’ allow data files to be saved. See section 3.3.6 for more information. For information on the ‘Display/Print Configuration Data’ options, refer to section 3.3.7.

As each unit is configured, the information can be stored to enable repeat configuration of the same unit, or to allow easily configuration of multiple identical units. The ‘Read Product…’ and ‘Write Product…’ options allow repeat configuration of a unit that was originally configured using a different PC or laptop. Also see section 3.3.6.

‘Edit Product Properties’ is password-protected, and allows changes to be made to information such as the serial number and MOD status of the file. ‘Reconnect to Product’ is used to confirm connection of a product during configuration. Other options may appear in the Program menu depending upon the attached product.

The Main ‘Edit’ menu

IMPORTANT NOTE: This section of the menu is used for selecting the COM port corresponding to the CAB-USB-0002 OR CAB-USB-0006 cable, and is required during initial set up of the cable.

The ‘Edit’ menu has three choices. ‘Options …’ is used during set-up to configure computer requirements (see section 2.4.2). ‘Undo’ and ‘Redo’ will include a description of the action that is to be modified.

The Main ‘View’ and ‘Help’ Menus

The ‘View’ menu allows the message console to be shown (box checked) or hidden. Refer to section 3.3.2.

3.3.2 Messages Window

The Messages window can be displayed above the status bar to show progress information during programming. The visibility of the Messages window can be determined using the checkbox in the ‘View’ menu. Under normal circumstances, it is not necessary to see the Messages window.

3.3.3 Status bar

The status bar displays connectivity information during programming. Connected =  🛡️  Not connected =  🛡️
3.3.4 **Products Window**

The initial **Products** window shows a list of JAC products that may be configured using the ProCS™ software, grouped together by type (Alert Generators, Audio Controllers etc.)

To expand each group, click on the arrow to the left of the group name, or double-click on the name. In each product group, a list of available products will be displayed.

Each individual product can be selected by clicking on the arrow to the left of the name, or double-clicking on the name to display the full product information.

Each product tree has ‘ProCS Setup’ as a line at the top of the list of editable functions. This shows the cabling arrangement for connecting each product to a computer to allow configuration using ProCS™. If two or more cabling versions are possible, there will be more ‘ProCS Setup’ lines.

This screen demonstrates the ProCS™ view of a connected JA37-001, and also a JA95-001 in demo mode.

Clicking on the product name will display the device in the Editing Window, and double-clicking the name or clicking on the arrow to the left of the name will open a ‘tree view’ of the components and functions of the unit that may be changed.

As JAC develops new products they will be added to the **Products** list in later software versions. **Always check that you are using the most recent version of the software.**

If the file in use is ‘Read Only’, the symbol <R> will appear beside the product name. An asterisk (*) in this location indicates that unsaved changes have been made to the file.

If a product is connected to the computer running ProCS™, an icon 🔄 will be shown beside the product name. The icon 🔄 signifies that a product is not connected.
3.3.5 Editing Windows

Initially, when a product has been selected the Editing Window will show a 3D view of the product with information panes below. These will display ‘Demo Mode Product Information’ (with the statement ‘Modifications to data in this file will not affect a connected product; it is for edit/demonstration purposes only’) or ‘Connected Product Information’ (with a list of the product data), and then ‘File’ (the data file information) and ‘Comments’ where information on the specific unit, customer or mission usage can be entered. As each item on the ‘Products’ tree is selected, a different window will open for editing.

3.3.5.1 Front Panel Switches

When ‘Front Panel Switches’ is selected from the ‘Products’ tree, the Editing Window will show the front panel (see below) to enable changes to be made to the customizable legends.

The list of configurable functions is interactive – in other words if the name of a front panel switch is changed using this software, the change will be incorporated in every other section that refers to that switch name. These changes will also be incorporated in the connector maps, which will include all modified legends and other configurable options that affect installation, and may then be printed out to give truly customized installation diagrams.

In the example shown below, the option ‘New…’ has been selected. A pop-up ‘New Label’ window will appear, allowing the user to create a customized legend – in this case, JAC. The new legend name will now be shown in the appropriate position on the faceplate representation in the software program, and will be used in all further references to that function (see sections 3.3.5.2 and 3.3.5.3).
3.3.5.2 Radios

When 'Radios' is selected from the Products tree, the Radio Assignments panes will be shown in the Editing Window (see below). The Transceivers list now shows the first line labelled 'JAC', to match the selection made in the 'New Label> Button Label' section (see 3.3.5.1 above.) A radio selection can be made from the dropdown list shown.

Click the Receivers, Public Address or Cockpit Voice Recorder tab to show a list of radios in a similar format to the Transceivers window.

Customized ‘JAC’ label

If it is desirable to add other radios, click on the Radios List tab for the list of radios. A new radio and its parameters can be added by clicking on (the 'New Radio' button). A 'New Rt' line will be added to the bottom of the list, and double clicking on each part of the line will highlight it to allow changes, as shown below. When the relevant details have been added, use the (‘Save Changes’) or (‘Cancel All Changes’) button as required. The added radio will then appear on the appropriate list (selected by a drop-down menu under 'Type').

Once a new radio has been saved, it cannot be deleted, but it can be edited if necessary.

Note: The 'built-in' radios listed on a shaded background cannot be removed or edited.
3.3.5.3 Other Configurable Settings

Selecting other functions from the **Product** tree will open similar Editing Windows, from which it will be possible to configure other settings, such as levels, connector pins, muting and voltages. Typical Editing Windows are shown below.

There will usually be three different selection methods – sliders, check boxes and buttons.

**Sliders** consist of a band showing the upper and lower limits of the value that can be selected, and a ‘handle’ that can be dragged to select a value within those limits. As the handle is moved, the ‘Selected Value’ will change to show the current value. Some of the sliders will have a ‘**Default Level**’ button – clicking on this will return the selected value to its default level.

**Check boxes** are used to choose options from a list by clicking on a box. A check mark in the box means that the item is selected, and an empty box means that it is not selected. These options are not usually mutually exclusive – in other words it may be possible to check every box.

**Buttons** are used to make a choice from a series of options that are usually mutually exclusive – in other words selecting one button will automatically deselect all the others within that option (for example, only one voltage may be selected). Some buttons may be ‘greyed out’ to show that they are not selectable because another button in a different field has not been selected.
3.3.5.4 Alerts and Messages

**WARNING:** Internal audio alerts and messages are intended only to supplement, not replace, airframe alerts such as 'low rotor RPM', 'engine out' or 'DH alerting'.

Audio files for aircraft alerts can be downloaded from the JAC website [www.jupiteravionics.com/audiosounds](http://www.jupiteravionics.com/audiosounds), or other suitable audio files may be used.

![Image of audio files](image1)

Selecting the 'Open...' in an 'Alerts' window will automatically default to the Jac/ProCS/alerts location where the ProCS files are stored on your computer, but subsequent uses will return the browser to the most recently used location.

Selecting the 'Store alerts in data file' check box allows alerts to be stored in the configuration data file.

Selected audio files may be played by clicking on the arrow button to the right of the Message/Alert line.

By right-clicking on a stored alert, the menu option 'Play with...' will allow you to listen to the stored alert.

An alert file is chosen by clicking on the desired stored file and then selecting 'Open...'.

A new audio file may be uploaded to the attached product using the 'Program' menu and selecting 'Program Jxxx-001 Messages...'.

![Image of 'Program' menu](image2)
3.3.5.5 Connector Maps

The Connector Maps Editing Window generates Connector Maps and Interconnects that show all the relevant information that has been added during the configuration process. This allows fully customized drawings to be printed for use by the installer.

‘Generate Connector Map’ Tools

The tool bar icons and functions associated with the generation of the connector maps are shown below:

- **Refresh** – starts generation to include latest changes
- **Zoom In**
- **Zoom Out**
- **Zoom to fit page**
- **Print**

View Connector Maps

![Connector Map Diagram]
3.3.6 Saving Changes

When a product is connected, all configured legend references, level settings and options are implemented and programmed into the product’s memory immediately as they are modified. When all required changes have been made to the connected unit, or if a new customized version has been created, it may be useful to keep a record of these changes.

If changes are made and the user closes ProCS, a reminder window will open.

To exit without saving, select 'Discard'.

By selecting 'Save', clicking on the save icon or selecting 'Save' 'Save As...' or 'Save All' from the 'Edit' menu, the 'Save File' window will open.

(The 'Hide Folders' and 'Browse Folders' buttons allow the user to switch between the expanded and collapsed versions of this window.)

The user is directed to the JAC data subfolder in the location selected during installation of the software. (If this is the first time that this computer has been used with the ProCS™ software, or if no data has yet been saved, the data folder will be empty.) The Jac/ProCS folder in the selected location on the computer (see section 2.3.3) also contains a folder labelled ‘Alerts’ for convenient storage of audio files.

The first time that a product configuration is saved, a new .pcs file will be created in the data folder. All subsequent changes will be saved to the same file without the 'Save file' prompt. By right-clicking on the file name and selecting 'Properties', it is possible to save the file as ‘Read Only’.

‘Save As...’ will allow the creation of a new file if some of the data has changed and saving both versions is desirable.

If more than one product has been configured, use ‘Save All’ to record all the data.

The 'Comments' window on the initial ProCS™ screen (see section 3.3.5) can be used to make specific notes about the saved version.

Note: Comments are not programmed into a connected unit – they are stored only in the data file.
3.3.7  Compare or Display/Print Configuration Data

The ‘File’ menu (see section 3.3.1) has two options – ‘Compare Configuration Data with File…’ and ‘Display/Print Configuration Data File…’.

This enables the user to compare the default version of the unit built in to ProCS™ to a version in a saved file, to compare two saved files by opening one in ProCS™ and selecting the other for comparison, or to print the data for the existing product file.

When the ‘Compare’ option is selected, an ‘Open File’ window allows the comparison file to be selected.

When the comparison file has been selected, click on ‘Open’.

A ‘Configuration Data Difference Report’ will open in your web browser, showing a side-by-side comparison of the two units, with the differences highlighted.

By selecting the ‘Show Only Differences’ checkbox at the top of the page, the report will be condensed so that only the differences are shown (see below).

- Show Only Differences

Both the full and condensed versions of the report may be printed if required.

Depending upon your web browser, it may be necessary to allow some blocked content if the ‘Show Only Differences’ checkbox does not function.
SECTION 4 – ORDERING A CUSTOM UNIT

4.1 Ordering a Custom Unit

The ProCS™ software makes specifying and ordering a customized unit simple and efficient.

| ![Green Check] | Note: Refer to Section 2 of the ProCS™ manual for software installation information, and Section 3 for a full description of the ProCS™ functionality. |

4.1.1 Launching the Software

After installing the ProCS™ software on a PC or laptop, launch the software by either checking the ‘Launch ProCS’ checkbox on the ‘Completing the ProCS setup Wizard’ window, by double clicking the ProCS™ icon on the desktop if that option was selected, or by opening it from the folder where it was saved during installation. Refer to Section 3 of the manual when necessary.

4.1.2 Specifying the Product Configuration

1. Select the required device from the ‘Products’ list.
2. Click on the product name to display the device in the Editing Window.
3. Double click the name or click on the arrow to the left of the name to open a ‘tree view’ of customizable features.
4. When all the required changes have been made, click on the ‘save’ icon.
5. The ‘Save File’ window will open (see section 3.3.6).
6. In the ‘Save File’ window, choose a file name for this configuration. All data will be saved as a .pcs file.
7. Email the .pcs file to JAC (sales@jupiteravionics.com). The .pcs file will then be used to create a fully customized device, with all front panel legends (where appropriate) and all levels and settings factory-set to meet your requirements.

| ![Green Check] | Note: Ensure that your order to JAC is cross-referenced to the correct .pcs file. |